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Recommended System Requirements

Currently, Ward’s Digital Slides are not compatible with Mac operating systems. 
The following are recommended system requirements for viewing these slides, located on a remote server.  

• Internet access is required for all viewing stations.
• Intel processor with 1 GHz or better processing speed.
• Windows XP or above
• 2 GB RAM or better
• 250 MB available hard disk space

Additional Assistance

For additional assistance, not found in the Help menu or in this file, you 
can contact us by the following methods:

E-mail: (Please include “Digital Slides” in the subject line)
 For specific requests regarding Ward’s Digital Slides:  wards.slides@motic.com
 For General Help with Ward’s Products:  ScienceHelp@vwreducation.com 
 For Customer Service:  customer_service@wardsci.com

Phone:
 Ward’s Customer Service:  1-800-962-2660

Fax:
 Ward’s Customer Service:  1-800-635-8439

On the Web:
 View the help videos at:  www.wardsci.com/Digitalslides

Mail:
 Ward’s Natural Science Est.
 P.O. Box 92912
 Rochester, NY 14692-9012

http://www.wardsci.com/Digitalslides
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Installation Instructions

(You may require administrator authority to install these files. If so, please contact your school’s IT department 
or system administrator.)

Insert the CD into your CD or DVD ROM drive.• 
 (If the program does not auto run, please open the drive and run the file called “Setup.exe”)

Follow the prompts to install the program.• 
A new icon (shown below) will be added to your desktop.• 

Open the Ward’s Digital Slides program by double clicking the icon. • 
 
You can also access the program through your programs menu from the Motic folder. 

You will be prompted to enter your User ID and Password (located on the cover of the CD you • 
received). Only one user at a time will be allowed to access the images with each specific User ID 
and password.

• You may prefer to utilize the “Remember” option so you do not have to log-in every time you wish 
to open DSV (Digital Slide Viewer). 

• If you have purchased multiple sets, you can change your log-in on the library screen as well, to 
allow access to those images. (See the instructions on page  14.)

Quick Start Guide
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How It Works

Ward’s Digital Slides Powered by Motic® is an extension of technology that has been used for over a decade in 
university education and research. 

A Ward’s microscope slide is the start of the process. We have selected some of our best slides for teaching, 
doing our best to use only the finest slides available. These aren’t just regular high quality Ward’s slides, these 
are the best of the best. 

Motic®, a leader in the microscope industry, then applied their 
experience in digital pathology equipment and software.  This 
experience has given the best quality scans possible.

The slide is placed on a scanning device, and every field of view 
is photographed using a high resolution camera. Once the entire 
slide is photographed, these individual images are combined 
to form a single, very large, composite image. This process is 
repeated using different objectives, creating a group of images 
photographed at different magnifications.

In order to view these very large images more easily and quickly, the viewer accesses only the images from 
the region and magnification selected. As you move on the slide, you may see areas that appear out of focus. 
These are new areas being downloaded. 

This image represents the whole composite image, with 
each individual capture represented by the black lines.

When you are viewing the area represented by the red box, 
only the individual captures you can see are downloaded.

As you move around the screen, new areas come into 
better resolution.
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When you first open the program, you will see the Ward’s Digital Slides Editor interface.

To view your digital slide library, click on the “Open Slides Library” icon at the top of the screen.

This will open the Digital Slide Viewer and ask for your user name and password. (Located on your CD)

If you do not see a link to the server in the slide library tree:
 Right-click in the slide library. A menu will open and allow you to add a server.
 Enter the server as  vwr.motic.com
 Click on the server to open the log-in window.

Expand the server and open your digital slide set by clicking on the folder with the set name.

Your First View

Check the Remember box after entering your 
information, and you will log-in automatically 
after the first time.
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Navigating the Library

When you first open the Digital Slides Viewer, your window should be similar to the image below. 
(Note: The first time you open a page of slides it may take a few minutes to load the thumbnails.)

If you cannot see your slide thumbnails when the Digital Slide Viewer opens: 

Open your Slide Library.•	
Click on the link  vwr.motic.com in the tree view of your Slide Library.•	
To view the contents of a folder in this view, click on the folder•	  name.

Tool Bar –
for more detail, 
see pages 18-20

View Control – 
for more detail, 
see pages 21-22

Slide
Thumbnail – 
for more detail, 
see page 22 
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The Slide Viewing Tab

After double clicking on a slide, you will automatically be taken to the Slide tab as the image is opened. 
There are many options available on this tab.

The default slide view has five basic parts.

1. The basic tool bar allows for image capture, advanced display options, and image adjustment.

2. The working area is where the slide is displayed.

3. The thumbnail shows the full slide image and highlights the displayed area.

4. The zoomer controls the magnification of the display.

5. The Z-Axis Stack controls the depth of field being viewed. (Only used on select slides.)

Tool Bar – for more detail, see pages 23-28

Zoomer –  
for more detail, 
see page 29

Z-Axis Stack – 
for more detail, 
see page 12
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Zooming In

When you first open a slide in the working area, the image will automatically adjust so that the entire image 
will fit into the working area.

If you wish to zoom in (increase the magnification), you can do so in one of three ways. One of these methods 
uses an icon in the tool bar. The other two methods use the zoomer bar located at the bottom center of the 
working area. Please be aware that, when using the zoomer bar,  the values referred to as objectives are the 
objectives that were used to scan the slide; this is not the total magnification. The camera acts as an ocular 
of approximately 10X. If you wish to make comparisons to a traditional microscope, you should multiply the 
current objective by 10.

The first method of zooming in uses the objective boxes on the left hand side of the zoomer. Clicking on these 
is similar to changing the objective on a traditional microscope.

10X

20X

40X

Displays current 
equivalent objective

The second method uses the slider bar located in the center of the zoomer. If you grab the slider and move 
it to the right, the current objective is increased. Dragging the slider to the left decreases the magnification. 
Using the slider allows you to adjust your zoom to intermediate values not available on a traditional 
microscope.  (Hint: If you are using a mouse with a scrolling wheel, the wheel also acts like the slider.)

The last method utilizes an icon in the tool bar. Click on the icon shown at the right, then make 
a box around the area you wish to display by holding a left click in one corner and pulling the 
second corner away from the first. The area contained in the box will adjust magnification and 
center to fit the working area.
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Pan and Scan

In order to view the entire slide, you will want to scan around the image. 

The first method of moving around the slide is to move into an area of the slide in the working area, grabbing 
the slide and pulling it in the desired direction.

In order to accomplish this, make sure that you have selected the move tool, located in the tool 
bar above the working area. When your mouse is in the working area, an icon that looks like an 
open hand will appear. (See image at right.). Holding a left click in any area “grabs” the screen and 
the open hand becomes closed. When you have “grabbed” the slide, the slide moves in whatever 
direction you pull it.

If you wish to use the keyboard, you can move around using the arrow keys. A single click moves the slide so 
you are viewing the next row of images in the direction of the arrow key you used. An up arrow click moves the 
slide one row of images down and a down arrow click moves the image upward. If you repeatedly tap or hold 
an arrow key, the slide will continue to move after the key is released.
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Capturing an Image

Ward’s Digital Slides can have images captured from them using two methods. These captured 
images are stills captured from the current working area or from a selected region within the 
working area. Depending on how you will be using the image may determine how you wish to 
capture it.

If you wish to have an image that you can paste directly into a document or presentation, you 
will probably use the “Copy to Clipboard” icon (shown below) located in the tool bar above the 
working area.

After clicking this icon, draw a box around the region you wish to capture by 
clicking and holding in a corner and drawing a box outward. When you release, 
the area bounded by the box is copied onto your clipboard and can be pasted 
directly into other documents, using a paste command.

You can also capture images to a file using the camera icon. When Ward’s Digital 
Slides Editor is open (Default), the image is captured into the preview window 
where it can be edited or saved. In this form, the default file type is .SFC which 
allows you to retain measurement data and some annotations.

If Ward’s Digital Slides Editor is not open, a dialog box will open asking where you want to save 
the file, and what file type you wish to save as. 

When using either method to capture an image, some features are not transferred with the 
image. The zoomer, thumbnail, and Z-axis stack control will not be captured. Measurement tools 
like the grid and size bar will transfer with the image.   



© 2012 Ward’s Natural Science Page 12

Z-Axis Stack

The Z-axis stack control allows you to “focus through” specimens. It indicates that the specimen 
was thick enough to require more than one layer of scanning in order to make the slide. Using the 
Z-axis stack is similar to changing the fine focus on a traditional microscope. 

Not all slides utilize the Z-axis. Because of the very large files the Z-axis creates, we have only used 
this feature on slides where the material is not fully viewable within a single depth of field.

When it is present, the Z-axis control slider begins at 0, or the central depth of field layer. 

If the slider is moved up in the positive direction, the slide moves to another scanned depth •	
of field below the previous layer. Functionally this is similar to focusing through material on a 
traditional microscope, moving toward the slide and away from the cover glass. (The stage on a 
traditional microscope would move up towards the objective.) 

Movement in the negative direction is away from the slide and towards the cover glass. (The •	
stage on a traditional microscope would move down, or away from the objective.) 

At the bottom of the slider is a figure that allows you to see where you are viewing within the •	
stack.

Examples of Z-Axis movement using a traditional Microscope.
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Annotation Using the Digital Slides Editor

There are many ways that you or your students can annotate slides in the Digital Slides Editor. Here are two 
simple methods.

Paint and Text Annotations
Use the Paint and Text control bars to create the annotations on the slide. Right click on a shape and it can be 
pulled forward. The photos below show how you can create a quiz question from the same image used in a 
lecture.

Measurement Annotations

Using the Measure tool bar, structures can be measured directly within the Image Editor. This information 
can be transferred if the file is kept in the .SFC format for the students to perform measurements on another 
computer as homework or to utilize the measurement bar and perform measurements by hand.

After you have made measurements using the 
measurement tools, you can export the measurements to 
Excel for analysis. Click on the Measure Table button in the 
control panel and click “export” to create an Excel file.
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Logging in to View Additional Slide Sets

If you wish to view more than one set of slides on a single computer, you will need to change your log-in 
information to view each set. You can make this change on the library tab in the tree view panel, as described 
in the instructions below.

In the tree view panel, right click on the server name (vwr.motic.com).•	
A window will open. Left click “Login With Another Account”.•	
Enter the log in name and password associated with the set you wish to view. (The log in name and •	
password are located on the CD cover.)
Click “OK’.•	
Open the server by clicking on the name. Your second set is now available.•	

You can record your log-in information for additional kits in the table below. Please remember that only one 
individual is allowed to be logged in at a given time. If you forget your log-in, please contact us and we can 
assist you in recovering your information.

Name of Slide Set User Name Password
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If you are already using Motic Images 2.0, the editing interface in the Ward’s Digital Slides Editor operates in 
the same manner. Images captured from the Ward’s Digital Slide Viewer can also be used with Motic Images 
2.0. 

The main window in the digital slides editor has five basic parts:

1.  The Menu bar allows you to change between specific tool bars and is located at the top. See the following 
page for more detail.

2.  The Tool bar is dependent on the menu selected. The contents of each tool bar are given in more detail 
starting with page 30. You can hide the tool bar by clicking the up arrow next to the “File” tab.

3.  The Preview Window shows thumbnails and file names of open images. Click on a preview image to open it 
in the Image Window. The preview window can be hidden using the arrow button located at the border of 
the preview window and the image window.

4.  The Image Window shows the image currently being viewed.

5.  The Control Panel shows specific tools and controls for actions that can be performed in the image window.
The contents of the control panel are described on the following pages. The control panel can be hidden by 
clicking the arrow located at the border of the control panel and the image window.

Ward’s Digital Slides Editor
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The File menu contains the tools you will use to create, open, save, acquire, 
and compare slide images. Using this menu, you will also be able to adjust 
your basic settings and create reports. For more detail, see pages 30-31.

The Edit menu contains tools to select and manipulate parts of an image, as 
well as the undo and redo commands. For more detail, see pages 32-33.

The Image menu allows you to adjust your image. For more detail, see 
pages 34-35.

The Measure menu contains tools that allow you to measure the structures 
within the image. For more detail, see pages 36-38.

The Help menu gives you information about the program. You may be asked 
for this information if you call for assistance. For more detail, see page 39.

Using Ward’s Digital Slides Editor – Menus and Tool Bars
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Using Ward’s Digital Slides Editor – Control Panels

The Paint control bar gives information about the color values (Red, Green, Blue), 
the position (X, Y) of the cursor on the image, and controls to create shapes on 
the image. When a shape is selected, a dialog box opens, allowing color and line 
thickness options to be set.

The Text control bar allows you to change the color, font, and justification of text, 
as well as placing text onto the image for annotation. Click on the “T” and then 
click on the location in the image where you wish to type.

The Measure control bar allows you to change the unit of measure and 
accuracy of a measurement. You can also change the color of the measurement 
or, by clicking on the “Measure Table” button, add or adjust the style of the 
measurements.

The Magnifier control bar opens a magnifier. To undock 
the magnifier, click on the first icon to move the magnifier 
into the image window. The area magnified is the area 
around the cursor, not the area under the magnifier 
window. In this control bar, you can also adjust the 
additional magnification applied by the tool.

The Audio control bar allows you to add audio files to an image. The audio file 
must be stored in a location the displaying computer can reference (e.g., a public 
server, or locally), and be saved as a .SFC file. To add files, right click on the play 
list icon and select “add”. This will open a window for you to locate the file you 
desire. To play the audio file, use the play, pause and stop buttons located next to 
the file name.
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DSV Library Tool Bar Icons

Slide Properties

The first icon on the library tab is the Slide Properties icon which will show you basic 
information about the slide. Clicking on this icon opens a window that shows the following 
information.  This information is not changeable by the end user. This information is also 
displayed if you hover over the thumbnail of a slide.

Name

• This is the  slide name that is displayed on 
the screen.

Physical Number

• This is the number of a physical slide that 
matches the digital slide.

Scan Objective

• This is the largest magnification objective 
used to scan the slide.

Mount Type

• This describes the way the slide was 
prepared.

Stain

• Describes the stain(s) used to create the 
slide.

Organism

• Where appropriate, lists the organism 
from which the slide was created. 

Thumbnail

• Shows the thumbnail image of the slide.
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DSV Library Tool Bar Icons
(continued)

Settings

 Clicking on the Settings icon will open a window for general settings.

Slide View
Animation:

When animation is checked and you click on an area •	
in the thumbnail while viewing a slide, you will see the 
image as the viewing area moves to your designated 
area. 
When animation is unchecked, the navigation within •	
the thumbnail “jumps” to the designated location and 
does not show the intervening space/image.

Movement Speed
This determines the speed of animation. For slower 
computers, turn the speed down or turn off animation 
to improve performance.

Grid Color
Select the color of the grid. The default color is black, although you may wish to change the color for 
improved visibility on a specific slide.

Scalebar Color
Select the color of the scale bar shown with the slides. The default color is black, although you may wish to 
change the color for improved visibility on a specific slide.

Magnifier Scale
Select an additional magnification value for the magnifier when it is used in the slide view. 

Soft Zoom
When selected, this option will allow you to exceed the maximum objective magnification. The 
enhancement is digital, so image quality may be decreased.

Slide List
Display Thumbnail with bigger icon:

Increases the size of the thumbnails in the slide library when viewed in thumbnail mode.

Temporary Files
Clears temporary files created by DSV and frees up storage space. This includes your stored thumbnails.

 
(NOTE: In order for any changes made to settings to take effect, close this dialog box using the “OK” button)
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Help

Clicking on the Help icon opens a window for the 
user manual for the program.

About

Clicking the About icon opens a window that displays
information about the program. You may be asked for
this information if you call for support.

DSV Library Tool Bar Icons
(continued)

EXAMPLE
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DSV Library View Control Icons

The view control tool bar contains two icons (circled in the diagram above).

The first icon hides or  shows  the Slide Library tree menu window.

The second icon switches the view between List View and Thumbnail View 

• Click the icon to change view types.
• In either view, a maximum of 30 slides will be available.
• To open a slide, double click the slide thumbnail or name.

The list view displays more information about each slide than the thumbnail view and can be 
sorted by name. Click on the “Name” header of the first column and the list will sort by slide 
name.
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The thumbnail view displays larger thumbnails of each image.

If you hover over a slide thumbnail, a popup window will open showing the information about the 
slide. You can also select the slide and then click on the slide properties icon.

Thumbnail Icons
In the thumbnail view, the slide image will contain icons in the lower right corner of each 
thumbnail. These icons are a visual source of information about the slide. A brief review of the 
icons and their meanings is below.

This icon represents a slide that is stored on a remote server. All of the slides in your sets will 
show this icon.

This icon identifies a slide that contains a Region of Interest (ROI) scan. All of the slides in your 
set have been scanned to remove the need for a ROI, but this icon identifies slides that have 
had areas enhanced to allow for better clarity. You will see this icon paired with the 3D icon.

The 3D icon identifies slides that have been scanned in a way 
that allows the user to “focus through” a slide on a Z-axis.

DSV Library View Control Icons
(continued)
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The slide properties icon displays the same slide information as it does on the Library tool bar. See page 18.

The Move / Grab tool is the default tool when a slide is first opened. It is used to navigate on the slide, and 
to make changes to the zoomer and Z-axis stack tools. Use this tool to “pan” on the slide by “grabbing” a 
region with a click and hold, and dragging the slide in the direction you wish to move it. Click on this icon to 
turn off other icons while working.

This tool allows you to select a region and automatically center the view, and increase the magnification to 
fit that region in the working area. If you select a region that would exceed the maximum magnification, the 
region will center and the slide will display at the maximum magnification.

Slide Properties

Move / Grab

Zoom To

DSV The Slide Viewing Tab
(Tool Bar)
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Capture

The following icons are used to capture images from Ward’s Digital Slides for use in your classroom.

“Capture to Clipboard” allows you to quickly get an image and import it into a document or presentation.

“Capture to File” allows you to save an image from the Digital Slide to your chosen location.

Capture (to Clipboard)

After clicking this icon, draw a box around the region you wish to capture by clicking and holding in a 
corner and drawing a box outward. When you release the box, the area bounded by the box is copied 
onto your clipboard and can be pasted directly into other documents by using a paste command.

Capture (to File)

Clicking on this icon captures all of the image displayed in the working area except the thumbnail, 
zoomer, and Z-axis stack.

If Ward’s Digital Slides Editor is open, the captured image is imported into Ward’s Digital Slides •	
Editor, and the image can be measured and manipulated as desired using the tools in Ward’s 
Digital Slides Editor.

If Ward’s Digital Slides Editor is not open, a save file dialog box will open for you to save the file •	
to your preferred location. The image can be saved as either a .JPG, or a .BMP file. If you save this 
way and open the file into Ward’s Digital Slides Editor, you will need to calibrate the measurement 
tools in Ward’s Digital Slides Editor. 

The saved file can then be imported into any compatible program.•	

DSV The Slide Viewing Tab
(Tool Bar) 

continued
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Synchronize
Synchronize allows you to affect two or more slides at the same time. If only a single slide is open, the 
icons will be inactive. If multiple slides are open, all open slides will be synchronized. Click on an icon 
once to synchronize, and again to stop synchronization.  

Fast Synchronize

Fast synchronize will make all movement and zoomer actions on one slide also occur on all other 
open slides. Z-axis adjustments do not synchronize. Use this option if you want to compare slides of 
differing scale or structures in specific locations. Movement and magnification are synchronized in a 
non-absolute manner. Two slides can be displayed at differing magnifications or at different positions 
on the slide. 

Fully Synchronize

Full synchronization aligns the slides on an absolute scale. Clicking within an image will fully align 
the position and magnification of all open slides to that of the slide currently being viewed. The full 
(absolute) synchronization uses the scale bars on the side for absolute position determination. Z-axis 
stack is not synchronized. Use this option if you wish to compare random fields from different slides of 
the same type, like blood or bacterial smears. 

DSV The Slide Viewing Tab
(Tool Bar) 

continued
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Options

Clicking on the Options icon opens a drop down menu with the following options.

Full Screen

Changes the active view to Full Screen mode.•	
Click “ESC” to return to normal view.•	

Tab All

Presents all open slides as tabs on the bottom of the •	
screen.

Split Horizontally

Makes all open slides viewable on the screen.•	
Automatically sizes the width of windows to fit all slides •	
on the screen from left to right.

Split Vertically

Makes all open slides viewable on the screen.•	
Automatically sizes the height of windows to fit all slides •	
on the screen from top to bottom.

Normal Display

The default view for a slide.•	
Rotate 90 Degree

Rotates view 90 degrees in an anti-clockwise  •	
(i.e., counter-clockwise) direction from normal.

This is not cumulative rotation.•	
Rotate 180 Degree

Rotates view 180 degrees from normal.•	
This is not cumulative rotation.•	

Rotate 270 Degree

Rotates view 270 degrees from normal in an anti-clockwise direction.•	
This is not cumulative rotation.•	

Rotate Anti-clockwise

90 degree increments in an anti-clockwise direction.•	
This rotation is cumulative.•	

Rotate Clockwise

90 degree increments in a clockwise direction.•	
This rotation is cumulative.•	

DSV The Slide Viewing Tab
(Tool Bar) 

continued
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Options (continued)

Magnifier
Turns the on screen magnifier on or off.•	
Additional magnification is adjusted in “Settings”.•	
Grasp the magnifier to move it on the screen.•	
The area around the cursor is magnified, not the area under the •	
magnifier.
This allows for additional magnification beyond that of scanning.•	

Zoomer
Turns the zoomer on and off.•	
Default = on.•	

 
Thumbnail

Turns the thumbnail in the view field on or off.•	
Default = on.•	

 
Label Image

Shows the slide label for the slide. (This option is not yet active.)•	
 
Scalebar

Turns the scale bar on or off.•	
Default = on.•	

 
Grid

Turns the grid function on and off •	
Default = off.•	
As the magnification of the image is increased, the grid scale automatically adjusts to match •	
the scale bar.

 
Mask

Turns the circular mask on or off.•	
Default = off.•	

DSV The Slide Viewing Tab
(Tool Bar) 

continued

Slide with circular 
mask on.
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Image Adjustment
Clicking on this icon opens a drop down menu with the following adjustments.

Gamma
Adjusts the luminosity of the image.•	
A higher factor number results in a darker image with •	
deeper shadows.
You may wish to increase the Gamma for use on a •	
whiteboard with the room lights on.
Lower factors result in an image with low color density and •	
few to no shadows.
A factor below 0.5 is not recommended since many details •	
will be lost.

Contrast
Adjusts the contrast of the image. You may use this to •	
adjust the image for best display on a monitor, or projected 
image.
The scales range from 0 (brightest) to 255 (darkest).•	
The Min Input controls the brightness of highlights.•	
The Max Input controls the brightness of shadows.•	
The closer the values of Min Input and Max Input, the •	
greater the contrast. 

Color
Adjusts the levels of the red, green, and blues displayed.•	
You may wish to use these to highlight specific structures.•	

Saturation
Adjusts the intensity of the colors.•	

Sharpness
Can clarify some images by enhancing focus. •	
High levels can appear pixilated at maximum magnification.•	

Settings
Functions the same as on the library tab. See page 19.

Help
Opens the program user guide.

About
When opened, gives basic information regarding the program. 
You may be asked for this information if you call for support.

DSV The Slide Viewing Tab
(Tool Bar)

continued
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The zoomer tool, located at the bottom of the work area, contains a number of buttons and a slider.

Objective Buttons
The objective buttons allow you to rapidly switch between magnifications. When changing •	
magnifications, the image remains centered on your current field of view.
Use the objective buttons to “simulate” the progression of objectives on a microscope.•	
The current objective is displayed between the slider and the fit image button.•	

Objective Slider
The objective slider allows you to move gradually through all of the available magnifications.•	
Use this slider to display structures that are not fully visible at standard objective magnifications.•	

 
Fit Image Button

Clicking on this button returns the magnification objective to the greatest value that will fit the entire •	
image on the screen.
This is the default magnification when opening a slide for viewing.•	

Full Screen Button
Displays the image on the full screen. •	
The thumbnail, zoomer and Z-axis Stack remain, but all tool bars are hidden.•	
Press ESC to return from full screen view.•	

DSV The Slide Viewing Tab
(Zoomer)
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Digital Slides Editor
File Menu Icons

New
Clicking on the New icon allows you to create a new file in the image 
window.

Open
Clicking on the Open icon opens a file. When used, you will be asked to 
locate the file you wish to open.

Save
Clicking on the Save icon saves the current open file. If the file has not already been saved, it will be saved to 
the default photo album, using the date and time as a file name.

Save As
Clicking on the Save As icon saves the file, allowing you to rename the file and place it into a folder other than 
the default. 

Open Slide Library
Clicking on this icon opens the Ward’s Digital Slide Viewer to access your available slide 
library.

Image Comparison
Clicking on this icon opens a split screen window that allows you to view two images 
side by side. Drag an image from the preview window into one side of the split screen 
to view. Drag a second preview image into the other side of the split screen to compare 
images. Use the sliders at the sides and bottom of each window to move the images into 
the desired position.

Album
Clicking on this icon opens a window displaying the contents of the default photo album. 
Files can be opened by double clicking on the thumbnail. 

(continued on the next page)
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Digital Slides Editor
File Menu Icons

(continued)

Report
Clicking on this icon allows the user to create a report using images from the preview 
window. Students can add text, print and edit  easily for their lab reports.

Settings
Clicking on this icon allows the user to change the default settings of the Digital Slides 
Editor.

Exit
Clicking on this icon exits the program. Any images that were not saved will be saved to 
the default capture folder.
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Digital Slides Editor
Edit Menu Icons

Undo
Removes the last action. Clicking Undo multiple times removes multiple 
actions.

Redo
Restores the most recent action undone. Use this to restore an action that 
was accidentally removed using undo.

Cut
Removes the area bounded by the selection marquee and places it onto the 
clipboard.

Copy
Copies the area bounded by the selection marquee and places a copy onto 
the clipboard.

Paste
Inserts the last material stored in the clipboard into the current image.

Rectangle Marquee
Creates a rectangular selection area. Click and hold to anchor a corner, drag 
to create the shape, and release to set the far corner. After the shape is 
drawn, the marquee can be adjusted by “grabbing” anchor points on the 
shape.

Circle Marquee
Creates a circular marquee. Click and hold to anchor the center. Drag to create the circle with a radius.

Ellipse Marquee
Creates an elliptical marquee. Click and hold to anchor the center. Drag to create a circle; then adjust the circle 
to be an ellipse by grabbing an anchor point.

(continued on next page)
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Polygon Marquee
Creates a marquee of multiple straight sides. Click to anchor the first side, drag to 
create the first side, and click to finish the line. Move the mouse to another location 
and click to create the next side. Continue until the shape is enclosed. The shape will 
be complete when the last point is joined with an existing point on the shape.

Irregular Marquee
Creates a freehand marquee. Click and hold to anchor the marquee. Drag around 
the shape you wish to enclose, and release. If you release before the shape is 
complete, the marquee will draw a straight side to the starting point from the place 
the click was released.

Select All
Creates a marquee that encloses the entire image.

Deselect region
Use to remove a marquee created accidentally.
 

Digital Slides Editor
Edit Menu Icons

(continued)
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Brightness / Contrast
Allows you to adjust the brightness and contrast of the image.

Hue / Saturation
Adjusts the hue and saturation of the image.

Red / Green / Blue
Adjusts the levels of red, green, and blue in the image.

Mirror
Reverses the image from left to right. The flip occurs along the vertical 
center of the image.

Vertical
Flips the image from top to bottom. The flip occurs along the horizontal 
center of the image.

Rotate 90
Rotates the image 90 degrees in a clockwise direction around the center 
point of the image.

Gray Scale
Removes color information and makes the image a gray scale image.

Invert
Reverses color information, forming a negative image.

(continued on next page)

Digital Slides Editor
Image Menu Icons 
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Digital Slides Editor
Image Menu Icons

(continued)

Image Size
Allows you to adjust the size of the image.

Filter
Opens a selection of image filters (shown at 
right) that can be applied to a selected area. 
If an area is not selected, the entire image will 
be affected by the filter.
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Line Measurement
Draws a line and returns a length measurement for the line. Left click and hold to start the 
line, drag and release to complete the line.

Rectangle Measurement
Draws a rectangle and returns width, height, contained area, and perimeter measurements. 
Left click and hold to anchor the shape. Move to create the shape, and release to set the 
opposite corner.

Circular Measurements
Returns radius, contained area, and perimeter. There are two methods for creating 
a circle measurement: Circle, and Circle (3 point).

Circle
Click and hold at the center of the circle you wish to define. Move the mouse to 
create a radius and release when the desired size is reached.

Circle (3 point)
Click on 3 points that would be located on the perimeter of the desired circle.

Arc
Draws an arc for measurement. Returns the angle, radius, arc length, and perimeter of the 
form. Click at the starting point, maximum height, and endpoint to create the arc.

(continued on next page)

Digital Slides Editor
Measure Menu Icons 
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Digital Slides Editor
Measure Menu Icons

(continued)

Ellipse
Draws an ellipse for measurement. Returns measurement for major and minor half axis, 
contained area, and perimeter. Follow the same steps as for drawing a circle. When the circle 
is complete, grab the anchor point on the perimeter and move to create the ellipse.

Irregular Shapes for measurement
Returns contained area and perimeter or length.

Polygon
Creates a multisided, closed shape made of straight lines. Click to start 
a line, draw the line, and click to anchor the line. The most recent click 
serves as the start point of a new side. The shape will be complete when 
joined with an existing point on the shape.

Freehand Line
Creates an open irregular shape. Click and hold to start the line, move the mouse to create the line, and 
release to end the line. As this is not necessarily a closed shape, only the length of the line is returned.

Irregular shape
The irregular shape functions like the freehand line. Click to begin the shape, draw the line, and release at the 
end of the line. The tool will automatically join the endpoints with a straight line to close the shape.

Angle
Draws an angle from three points. Returns the measurement of the angle in degrees. Click 
to create the endpoint of one line segment to the vertex. Click the vertex and draw the line 
to the endpoint of the second segment. 

(continued on next page)
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Auto Segment
Uses color tolerances to identify unique 
structures within an image. These structures 
are then defined as areas with continuous 
borders and are highlighted green. Use auto 
calculate to return the measurement. 

Auto Calculate
Used after auto segment; returns information about the 
segmented areas including:

Number of Objects•	
Minimum, Maximum, Average, and Total Area•	
Minimum, Maximum, and Average Perimeter•	

Digital Slides Editor
Measure Menu Icons

(continued)
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About
When clicked, gives basic information about the 
program. You may be asked for this information  
if you call for support.

Help
Opens an embedded user manual for the program.

Digital Slides Editor
Help Menu Icons 

EXAMPLE
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